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Lesson 1 

Planning Criteria 
 

Space Planning can be done for an existing space or a new space.  It is similar to the top-

down or bottom-up approach taken in mechanical design.   

 

An outside-in approach is where you are introduced to an existing building and asked to 

maximize the space and function.  In an outside-in approach, you must work with the 

existing exterior walls.  You may be able to move, add, or demolish existing doors and 

windows.  You may be able to extend or contract specific exterior walls.  However, you 

are constrained to work with the existing architecture.  This can be a very challenging 

type of project as you seek to preserve the character of the building and blend with the 

existing structure. 

 

An inside-out approach involves a new building.  When starting a new building project, 

you define your space needs and from that, determine the exterior form and size.  Often, 

you can use the criteria you develop when looking for space to rent for a business. 

When using ACA for space planning, you use Spaces, Areas and Boundaries.  In the 

inside out approach, spaces are used to define rooms and space boundary edges are used 

to define walls. A group of spaces inside a boundary can be used to define separate 

cubicle areas to form a department.  

Before you can start defining your space, you need to determine your space needs.   

Meeting with the people who will be using or building the space accomplishes this.   
 

An easy way to track your space criteria is to create a Criteria Table. 
 

For example, a non-profit group that wants to establish a counseling center in the 

downtown area has approached you with the following criteria: 
 

Criteria Table 

Administrative Space Size 
Office, Nurse 19.5 NSM (210 NSF) 
Office, Physician 13.9 NSM (150 NSF) 
Office, Rehabilitation Counselor 11.2 NSM (120 NSF) 
Office, Social Worker 11.2 NSM (120 NSF) 
Office, Office Manager/Bookkeeper 11.2 NSM (120 NSF) 

Clinic Area  
Reception Area 11.2 NSM (120 NSF) 

Waiting Area 27.9 NSM (300 NSF) 

Exam Room/Intake Room 11.2 NSM (120 NSF) 

Group Therapy/Conference Room 27.9 NSM (300 NSF) 

Common Area  
Coffee/Snack Room 11.2 NSM (120 NSF) 

Utility/Storage/Mail 11.2 NSM (120 NSF) 

Restrooms Common to adjoining complex 

Corridor Minimum to meet ADA 
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When looking at space planning, you also need to look at which areas need to have 

adjacencies.  In other words, certain spaces need to be located next to each other. 

 

For example, the receptionist should be located adjacent to the waiting area.  It also 

makes sense to locate the nurse and physician next to each other, as they will probably 

want to confer often.   

 

You look at adjacency requirements by sketching relationships. 

 
PHYSICAL RELATIONSHIPS BETWEEN SPACES 

 

Legend 

1   ADJACENT 

2   CLOSE/INSIDE SPACE 

3   CLOSE/OUTSIDE SPACE 

4   LIMITED TRAFFIC 

X  SEPARATION DESIRABLE 

 

Using a legend to help you sort out the relationships between spaces will make it easier 

for you to arrange the spaces. 

 

Criteria Table 

Administrative Space Size Adjacency 

Office, Nurse 19.5 NSM (210 NSF) 1 

Office, Physician 13.9 NSM (150 NSF) 1 

Office, Rehabilitation Counselor 11.2 NSM (120 NSF) 2 

Office, Social Worker 11.2 NSM (120 NSF) 2 

Office, Office Manager/Bookkeeper 11.2 NSM (120 NSF) 2 

Clinic Area   

Reception Area 11.2 NSM (120 NSF) 1 

Waiting Area 27.9 NSM (300 NSF) 1 

Exam Room/Intake Room 11.2 NSM (120 NSF) 4 

Group Therapy/Conference Room 27.9 NSM (300 NSF) 2 

Common Area   

Coffee/Snack Room 11.2 NSM (120 NSF) 4 

Utility/Storage/Mail 11.2 NSM (120 NSF) X 

Restrooms Common to adjoining complex 3 

Corridor Minimum to meet ADA 1 
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Exercise 1-1: 

Modifying the Space Tools Palette 
 

This exercise reviews the following concepts: 

 

• Content Browser 

• Tool Palettes 

• Using idrop 

 

File:   New from Scratch 

Estimated Time: 15 minutes 

 

1. 

 

Launch ACA 2008. 

   

2. 

 

Select the Spaces tool palette. 

   

3. 

 

Use the scroll bar to look at the space tools 

already available. 
 

These tools are preloaded when ACA is installed.

   

4. Scroll down until you see the More Spaces Tools. 
 

Select the More Spaces Tools by left clicking on it. 

 

5. 

 

Verify the heading says Imperial. 
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6. 

 

You’ll see that ACA already has several 

space tools defined for different types of 

building models. 
 

Since the space we’ll be defining is a 

medical office, select the Medical link. 
   

7. 

 

Locate the GENERAL_EXAM tool on the first page. 

Place your cursor over the idrop symbol.  The cursor 

will change to an eyedropper symbol. 

Hold down the left mouse button to fill up the 

eyedropper, then drag and drop the symbol on to your 

Spaces tool palette. 

 

8. 

 

You now have added this tool to your palette. 

   

9. 

 

 

Repeat to add the NURSE_MGR tool to your palette. 

10. 

 

Select the Spaces link on the top of the 

page. 

   

11. 

 

Select the Commercial link. 

   

12. Select the CONFERENCE_SMALL tool. 

Drag and drop onto the palette. 

   

13. 
 

 

Select Page 4 at the bottom left on the page. 

14. 

 

Select the WORKSTATION_ LARGE 

tool. 

Drag and drop onto the palette. 
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15. 

 

Select the WORKSTATION_ SMALL 

tool. 

Drag and drop onto the palette. 

16. Close the Content Browser. 
 

 

17. Save as ex1-1.dwg.  

 

 
 

 

Exercise 1-2: 

Editing Space Styles 
 

This exercise reviews the following concepts: 

 

• Space Styles 

• Style Manager 

• Property Set Data 

 

File:   ex1-1.dwg 

Estimated Time: 40 minutes 

 

Refer to the Criteria Table on page 1-2. 

This lists the types of spaces we need to have defined. 

 

1. Open or continue working in ex1-1.dwg. 
 

 

 

 

Highlight the Nurse-Manager tool. 

Right click and select Import ‘Nurse_MGR’ 

Space Style. 

 This adds the space style to the Style Manager for the active drawing file. 
 

2. 

 

Highlight the Nurse-Manager tool. 
 

Right click and select Space Styles. 

   

3. Change the Name to NURSE_OFFICE. 

   

4. Select the Property Sets button. 
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5. Note that you already have property data 

defined for your space. 
 

This data will be used for square footage 

calculations and for any schedule tables you 

want to create. 
 

Press OK to close. 
 

6. Select the Design Rules tab. 
 

 

 

7. Set the Area to 210 SF. 

Set the Min to 210 SF. 

Set the Max to 230 SF. 

Set the Length to 20′. 
Set the Min to 6′. 

Set the Max to 38′. 
Set the Width to 10′-6″. 

Set the Min to 6′. 
Set the Max to 38′. 
Set the Gross Offset to 6″. 
 

 This allows for wall thickness between adjacent spaces. 

You can also set to 0″, but then some of the office space will be eaten by wall 

thickness. 

Press OK to ignore any error messages that pop up. 
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8. 

 

 

 Select the Display Properties tab. 

Highlight Plan. 
 

9. 

 

 

Select the Display Properties button located on the right. 

10. 

 

Select the Layer/Color/Linetype tab. 

   

11. 

 

Locate the Base Hatch 

Display Component. 

Set the Color to green. 

 

12. 

 

 

Select the Hatching tab. 

Set the Hatch to ANSI33. 

Set the Scale to 48. 

Set the Angle to 0. 

Press OK. 

13. Select the Floating Viewer tool located in the lower left corner of the Styles 

dialog. 
  

14. 

 

Select 3D Hidden from the drop-down list. 
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15. 

 

 

Select Plan Only from the view display drop-down. 

16. 

 

 

Your space is previewed in the preview window. 
 

Press OK to close the Styles dialog. 

17. 

 

 

Highlight the General_Exam tool. 

Right click and select Import 

‘General_Exam’ Space Style. 

 

 This adds the space style to the Style Manager for the active drawing file. 
 

18. 

 

Highlight the General_Exam tool. 
 

Right click and select Space Styles. 

 

19. 

 
 

We see that the General_Exam space style has been 

added to the list of available styles. 

20. Highlight the General_Exam space style. 
 

Select the General tab. 
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Change the Name field to  

120 NSF SPACE. 
 

Under Description, enter all the room 

descriptions that will be 120 SF. 

  

21. 

 

 

Select the Design Rules tab. 
 

Set the Area to 120 SF. 

Set the MIN to 120 SF.   

 (This means the space can 

 be no less than 120 SF) 

Set the MAX to 140 SF.   

 (This means the space can 

 be no more than 140 SF.) 
 

22. Set the Length to 10′. 
Set the Min to 6′. 
Set the Max to 23′. 
Set the Width to 12′. 
Set the Min to 6′. 
Set the Max to 23′. 
Set the Gross Offset to 6″. 
 

23. 

 

 

 Select the Display Properties tab. 

Highlight Plan. 
 

24. Select the Display Properties button located on the right. 
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25. 

 

 

 Select the Layer/Color/Linetype tab. 

Highlight the Base Hatch. 

Set the Color to blue. 
 

26. 

 

 

 Select the Hatching tab. 

Set the Hatch to DOTS. 

Set the Scale to 48.00. 

Set the Angle to 45.00. 

Press OK. 
 

27. Select the Floating Viewer tool located in the lower left corner of the Styles 

dialog. 
 

 

 
 

 

 

Your space is previewed in the Viewer. 
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28. 

 
 

Highlight the Standard Space Style. 
 

Right click and select Copy. 

29. 

 

Highlight Space Styles. 
 

Right click and select Paste. 

   

30. 

 

Highlight the Standard (2) space style. 
 

Select the General tab. 
 

Change the Name field to 150 NSF SPACE. 
 

Type in Physician’s Office in the Description field. 

 
  

31. Select the Design Rules tab. 
 

Under Space Names: 

Select Medical Building from the drop-

down list. 
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32. 

 
 

 Set the Area to 150 SF. 

Set the Min to 150 SF. 

Set the Max to 160 SF. 

Set the Length to 10′. 
Set the Min to 6′. 

Set the Max to 27′. 
Set the Width to 15′-0″. 

Set the Min to 6′. 
Set the Max to 27′. 
Set the Net to Gross Offset to 6″. 
 

33. Select the Display Properties tab. 

Highlight Plan. 
 

34. 

 

Select the Display Properties button located on the right. 

  

35. 

 

 

 Select the Layer/Color/Linetype tab. 

Highlight Base Hatch. 

Set the Layer to A-Area-Spce-Patt. 

Set the Color to magenta. 
 

36. 

 

Select the Hatching tab. 

Set the Hatch to GRASS. 

Set the Scale to 12. 

Set the Angle to 0.00. 

Press OK. 
   

37. Select the Floating Viewer tool located in the lower left corner of the Styles 

dialog. 
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Your space is previewed in the Viewer. 

38. Close the Style Manager. 
 

 

39. Save as ex1-2.dwg.  

 
 

 
 

 

Exercise 1-3: 

Copying Space Styles 
 

This exercise reviews the following concepts: 

 

• Space Styles 

• Style Manager 

• Copy Style 

• Paste Style 

 

File:   ex1-2.dwg 

Estimated Time: 15 minutes 

 

1. Open or continue working in ex1-2.dwg. 
 

 

2. 

 

Highlight the Corridor tool. 
 

Right click and select Space Styles. 

   

3. 
 

 

Select the Open tool. 

4. 

 

Browse to the Imperial folder under 

Documents and Settings\All Users\Application Data\ 

Autodesk\ACD-A 2005\enu\Styles\Imperial. 
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5. 

 

 

Open  

Spaces – Commercial (Imperial).dwg. 

6. 

 

 

Expand the Space Styles category under 

Architectural Objects. 
 

You see the same tools as we had in the Content 

Browser. 

7. 

 

Locate the CONFERENCE_SMALL space style. 
 

Right click and select Copy. 

   

8. Highlight the Space Styles category in the  

ex1-2.dwg.   
 

Right click and select Paste. 

   

9. 

 
 

Highlight the CONFERENCE_SMALL space 

style. 
 

Select the General tab. 
 

Change the Name field to 300 NSF SPACE. 
 

Type in Conference Room\Waiting Area in the 

Description field. 
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10. 

 
 

 Select the Dimensions tab. 

Set the Area to 300 SF. 

Set the Min to 300 SF. 

Set the Max to 310 SF. 

Set the Length to 10′. 
Set the Min to 6′. 

 

Set the Max to 52′6″. 

Set the Width to 30′. 
Set the Min to 6′. 
Set the Max to 52′ 6″. 

Set the Gross Offset to 6″. 
 

11. 

 

 

 Select the Display Properties tab. 

Highlight Plan. 
 

12. 

 

Select the Display Properties button located on the right. 

   

13. 

 

 

 Select the Layer/Color/Linetype tab. 

Highlight Base Hatch. 

Set the Color to BYLAYER. 
 

14. 

 

Select the Hatching tab. 

Set the Hatch to AR-SAND. 

Set the Scale to 1′-0″. 

Set the Angle to 45.00. 

Press OK twice. 
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15. 
 

Select the Floating Viewer tool located in the lower left corner of the 

Styles dialog. 
 

 

 

 

 

 

Your space is previewed in the preview window. 

16. Close the Style Manager. 
 

 

17. Save as ex1-3.dwg.  

 

 
 

 

 

Exercise 1-4: 

Adding Styles to the Palette 
 

This exercise reviews the following concepts: 

 

• Space Styles 

• Style Manager 

• Copy Style 

• Paste Style 

• Delete Tool 

• Tool Properties 

 

File:   ex1-3.dwg 

Estimated Time: 10 minutes 

 

1. Open or continue working in ex1-3.dwg. 
 

 

2. 

 

 

Go to Format→Style Manager. 

3. 

 

Expand the Space Styles category in the ex1-3.dwg.   



Copyrighted 
Material 

 
Copyrighted 

Material 
 

Copyrighted 
Material 

 
Copyrighted 

Material 

Lesson 1: Planning Criteria 

1-17 

4. 

 
 

Drag the 120 NSF SPACE style onto your SPACE tools 

palette. 
 

Drag the 150 NSF SPACE style onto your SPACE tools 

palette. 
 

Drag the 300 NSF SPACE style onto your SPACE tools 

palette. 
 

Drag the NURSE_OFFICE style onto your SPACE tools 

palette. 
 

Close the Style Manager. 
 

5. 

 

Highlight the NURSE_Manager tool on 

the palette. 
 

Right click and select Delete. 

   

6. 

 

 

Press OK to complete the 

deletion. 

7. 

 

 

Highlight the NURSE_OFFICE tool. 
 

Right click and select Properties. 

8. Browse through the Properties. 
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9. 

 
 

Note that the Base Area is 210 SF – the value you 

assigned when you edited this style. 

10. Locate the Constrain field. 
 

Select Area under Constrain. 
 

This requires the space to always equal the 

specified area. 
 

Press OK to close the Properties dialog. 
 

11. Save the file as ex1-4.dwg.  

 

 

ACA 2005 includes a built-in drawing management system.  This system consists of the 

Project Browser and the Project Navigator.  The Project Browser allows you to define 

new projects and assign information, such as location, sub-contractors, contact 

information, permits, etc.  The Project Navigator allows you to organize your drawings 

into categories and organize your drawing sheets. 
 

 

 

 

Exercise 1-5: 

Starting a New Project 
 

This exercise reviews the following concepts: 

 

• Project Browser 

• Adding a New Project 

 

File:   ex1-4.dwg 

Estimated Time: 10 minutes 

 

1. Open or continue working in ex1-4.dwg. 
 

 

2. 

 

Go to File→Project Browser. 
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3. 

 

 

Browse to the folder where you want to store your project 

files. 

4. 
 

Select the New Project tool located in the lower left of the dialog. 

   

5. 

 

 

Enter 10-1001 as the Project Number 
 

Enter Medical Building in the Name field. 
 

Enter Space Planning in the Description field. 
 

Press OK. 

6. 

 

The Current Project now shows Medical 

Building. 

7. Press Close.  
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The Project Navigator will launch with the 

project information. 

8. Save as ex1-5.dwg.  

 

 

 

Constructs are used to organize your drawing. 

 

There are three types of content used in defining a construct: 

 

� Drawing objects:  spaces, areas, ceiling grids, and walls are all examples 

of types of constructs 

 

� Element references:  Furniture, casework, landscape objects are all 

examples of elements which may be reused throughout a model design 

 

� Combination of drawing objects and element references:  a ceiling grid 

with lighting fixtures or a floor plan with furniture are examples of this 

type of construct. 
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Exercise 1-6: 

Adding Constructs 
 

This exercise reviews the following concepts: 

 

• Adding Constructs 

• Project Navigator 

 

File:   ex1-5.dwg 

Estimated Time: 10 minutes 

 

1. Open or continue working in ex1-5.dwg. 
 

2. 

 
 

Launch the Project Navigator Palette, if it is 

not already visible. 
 

You can enable it by going to 

Window→Project Navigator Palette. 

3. Select the Project tab. 
 

Note that we have defined a project with one 

level (this means it is a single story building) and 

one division. 
 

Divisions are used to allow users to break up a 

model into smaller files.  The files could then be 

used as external references and shared among 

users. 
 

Levels are horizontal portions of a building 

model.  Divisions are vertical portions of a 

building model.  An East/West wing would be an 

example of a division.  A division could also be 

used for phasing or demolition. 
 

The main plus to defining different divisions is 

to quickly and easily create views and navigate 

around a large building model. 
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4. 

 

Select the Constructs tab. 
 

Note that there are two main folders.  The Constructs folder is 

used to store drawing objects.  The Elements folder is used to 

store blocks, which are used in multiple occurrences. 

   

5. 

 
 

Expand the Architectural folder. 

6. 

 

Highlight the Architectural 

folder. 

 

Right click and select 

New→Category. 

7. 

 

 

Rename the folder Spaces. 

8. Save the file as ex1-6.dwg.  

 

 

 

� If you start your drawing using the ACA template, there are several 
styles already imbedded.  This automatically makes your file size 
bigger than it needs to be as you probably won’t be using all the 
styles. 

� If you make changes to your palette, any changes will be saved with 
your application – not just the drawing.   

� Styles in the Style Manager are organized in alphabetical order.  
When you rename your style, it will shift to the correct location in the 
style manager list. 

� If you want custom styles to be available to all your drawings, open 
the template drawing you use and save all the styles to the template. 

 

 

 
 


